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Timelapse Template Guide
A reference guide to Timelapse templates, and how to create them with 
the Timelapse Template Editor 1

This guide assumes that you have first gone through the Timelapse 
QuickStart Guide, which is Part I of this series. That guide provides basic 
information on how to use Timelapse, the role of templates, and the 
Timelapse Template Editor. This guide builds upon that, where it adds 
details. A later section on Folder-level metadata also assumes that you have 
gone through the Timelapse Metadata Guide (Part 4 of this series),as that 
guide explains what folder-level metadata is, what it is used for, and how it 
is used.

The Timelapse Template Guide explains how to use the Timelapse Template 
Editor  (included with the Timelapse Software). The Template Editor allows 
you to create a template (a file with the .tdb suffix ) that specifies the data 
field tags you want to fill in when analyzing your images, and (optionally) a 
folder-based information hierarchy that associates metadata field tags with 
each one of your folders.Timelapse then uses that template to:

•	 specify the data fields that appear within Timelapse, which the analyst 
will fill in with tagging data as images are reviewed, 

•	 (optional) specify folder-specific hierarchy and data fields within the 
folder data tab, which the analyst will fill in with metadata while 
navigating images,

•	 structure the database columns that will hold your image and folder tag 
data, and  

•	 decide what fields to export to a CSV file 

Creating and modifying templates is easy, as its mostly a matter of form 
filling once you decide upon the relevant image tags, and folder structure if 
you are using folder metadata) your project. 

Finally, we recommend watching Video Companion: The Timelapse 
Template Editor, which illustrates many of the functions described in this 
guide.

1What you see when you run Timelapse software may not exactly 
match the screen images in this guide, due to updates made in the 
software after these screen images were taken. These differences 
should not affect your general understanding.
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Introduction
The kinds of information that you or your organization want to track from 
camera trap images will be specific to your domain, your project and its 
goals and purposes, the kinds of images you want to analyze, and even the 
particular data you want to get out of it. Across domains, data requirements 
will certainly differ. For example, a wildlife oriented ecology domain may 
want data tags such as Species and Count, while a fisheries domain may want 
tags such as #Anglers and #Boats. Tags may even differ within a domain. 
One wildlife project may only be concerned with the presence of certain 
predacious species. Another wildlife project may want a broader set of tags 
specifying all species in the area, the sex and age of each entity, the presence 
of vehicles and people, and other factors such as weather and ground cover.

This is where the Timelapse Template Editor and the template file (a file with a 
.tdb suffix) come in. A project manager uses the Template Editor to specify 
the data fields the analysts will use to tag each image, which is saved as 
a template file. The project manager can optionally specify the folder 
hierarchy and associate data fields with folders, which the analyst would 
fill in while navigating through different image folders. That template file is 
then deployed (copied) to the root folder of an image set. When Timelapse 
loads that template and image set, it uses the specification contained within 
the template to create the look and feel of the fill-in data fields that appear 
in the Timelapse window's interface, and to structure how tag data will be 
stored in the Timelapse database (.ddb file). 

The Template Editor defines a few mandatory data fields that must be 
included in all templates. Beyond that, any data field can be defined by 
selecting and configuring the various data types the Editor makes available: 
text, numbers, checkboxes, menus, and dates. This means that Timelapse 
can be customized to a broad variety of domains and purposes. It also 
explains why Timelapse has been used for many different purposes: wildlife 
ecology, fisheries management, social studies, instrument monitoring, etc.

Internally, the template .tdb file is actually an SQLite database, where your 
specifications is saved in database tables. However, you don’t have to know 
anything about SQL or databases, as the Template Editor takes care of all the 
grotty technical details.

While there is some overlap between this guide and the Timelapse 
QuickStart Guide, this document goes into much more detail about the 
template and how the Template Editor works. 

Creating the right template for your needs
You should give considerable thought to the information you want to capture 
as tags and how it is structured as data fields. When you craft a template, 
you are essentially creating a standard that specifies: 
•	 what analysts should look for and tag when inspecting the images; 
•	 how data fields are displayed in Timelapse, where the data field is given a 

label and tooltip that helps the analyst understand what it is for; 
•	 how the tags entered by analysts are named and recorded in the 

Timelapse database (.ddb) file as data;
•	 how a folder/sub-folder hierarchy adds structure to how images are 

stored and how meaningful data can be associated with those folders;
•	 which data should be exported to a .CSV file;
•	 the expected format of the data;
•	 what data will be available for statistical analysis;
•	 the expected number of tags the analyst must consider: the fewer the 

data fields for the analyst to fill in, the faster the tagging task.

Doing it right requires planning. We recommend talking others in your 
organization to understand their needs. Test your templates, ideally with 
experienced analysts who can give you feedback, before deploying them 
widely. Tag a sample image set to collect some data, and see how amenable 
that collected data is to later analysis (e.g., statistics). 

How to deploy templates
A project manager, or whoever is in charge, usually creates a master 
template, which is just the template .tdb file produced using the Template 
Editor. That template normally serves as the standard for how all images 
(and optionally folders) in that project should be analyzed and tagged. 

A template file can be deployed in various ways. A common approach simply 
copies  the template into the root folder of one or more image sets: how you 
decide to divide your images into images is up to you. When Timelapse loads 
the template in that image set, it will use the template found in the root 
folder to construct the Timelapse interface and to create a Timelapse Data 
database .ddb file, which in turn will hold the tagging data for that image set. 

There are many variations to the above, as it depends on how you plan to 
deploy Timelapse. The Timelapse FAQ web page includes an entry discussing 
various other deployment strategies. 

https://timelapse.ucalgary.ca/FAQ
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The Template Menu
Before diving into details, let's quickly discuss the offerings of the template 
editor's menu bar. 

File menu
The File menu is mostly self-explanatory. Unlike other applications, there is 
no 'Save...' menu item as all edits are automatically saved to the template 
.tdb file as you edit.
•	 New template... create a new template file in a folder of your choosing.
•	 New template based on a standard... create a new template file in a 

folder of your choosing, where that template is pre-configured to match 
the selected metadata standard (see the Timelapse Metadata Guide for 
an explanation of metadata standards).

•	 Open template... open an existing template file.
•	 Recent templates... open a template from a list of recently edited 

templates.
•	 Upgrade Timelapse files to latest version... upgrade old selected 

Timelapse files (i.e., pre version 2.3) to the current version. Alternately, 
Timelapse will inform you if you are attempting to open an old file, and 
will raise the appropriate dialog to let you upgrade it. This menu item will 
disappear in the future.

•	 Close the current template file.
•	 Exit the template editor

Edit menu
The Edit menu is operational only when editing a template.
•	 New folder level... creates a new level in the metadata information 

hierarchy. This is described later in this tutorial, and in more detail in the 
Timelapse Metadata Guide for an explanation

View menu
The View menu is operational when editing a template.
•	 Inspect File Metadata... raises a dialog that allows you select a typical 

image set file, and inspect the metadata that file contains. Its purpose is 
to let you see if any file metadata is worth recording. If so, you can create 
a Note data field, where you can later have Timelapse automatically 
load each file's metadata value into that field.  For example, if the file 
contained metadata for Ambient Temperature, you could create a data 
field called Temperature, where Timelapse will populate that field with 
each file's Ambient Temperature value.

•	 Show all columns... displays other non-editable data columns used by 
Timelapse. While useful for debugging, they are likely of little interest to 
most people. 
	» ID: The internal database ID of each row
	» Control order: the sort order for displaying controls in the Timelapse 

user interface
	» Spreadsheet order: the sort order for the columns in the .CSV file. 

Help menu
The Help menu should be self-explanatory. You can use it to: 
•	 quickly navigate to various pages on the Timelapse web site, 
•	 view various video tutorials,
•	 join or send email to the Timelapse mailing list,
•	 find more about the Timelapse version you are running, including the 

ability to update to the latest version 

https://timelapse.ucalgary.ca/Guides
https://timelapse.ucalgary.ca/Guides
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The minimal template
This section explains several Template Editor fundamentals. You will create 
and deploy the minimum template required to use Timelapse. To follow 
along, create a folder called TemplatePractice. Copy the Station2 folder and 
its contents from your PracticeImageSet folder into it. TemplatePractice is 
now your image set folder for this tutorial. 

Creating the minimal template
1.	 Start the TimelapseTemplateEditor. A window displays brief instructions. 

2.	 Create a new template. Select File | New template..., navigate to your 
TemplatePractice folder and click Save. 
	» The Template Editor window will display the required data fields. 
	» A new file titled TimelapseTemplate.tdb should appear in your 

TemplatePractice folder. 

3.	 The template includes the mandatory data fields required by Timelapse 
along with their default settings. Cells in grey are not editable, while cells 
in white are editable. These mandatory controls cannot be removed.  

4.	 Quit the editor. Start Timelapse. Select File | Load template, images and 
video files.... Navigate to the newly created TimelapseTemplate.tdb file in 
the Station1 folder. This loads the template and all images in that folder.  

5.	 Compare the fields in the Template with the fields in the Timelapse Data 
Entry panel above. You will see a one to one match.  
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Editor and minimal template explained
The Template Editor interface
The Timelapse Template Editor interface contains several tabs.
•	 Brief instructions on how to use the editor.
•	 Image data fields: an editor for creating data fields for images.
•	 Folder data fields: an editor for creating data fields for folders (metadata).

Each editor tab is divided into four areas..
•	 Data field editor (top). Each row in this area specifies a single data field 

item and its attributes. 
•	 User interface preview area (lower middle) shows how the data will be 

displayed as fields in the Timelapse user interface. 
•	 CSV preview area (bottom) shows the data column names and their order 

when data is exported to a .CSV file.
•	 Row addition/deletion controls (right) are buttons that let you add or 

remove particular types of rows into the table.

•	

Note. 
- White fields are editable. 
- Gray fields are not-editable.

Mandatory fields
Every template includes four mandatory data fields, each displayed as a row 
in the table.  Each row specifies a different data type as detailed in the Type 
column. For the first three mandatory fields below, Timelapse will automati-
cally fill in the data when it loads your images. 
•	 File: name of the image file. 
•	 RelativePath:  path from the image set's root folder to the sub-folder 

containing the image, if any.
•	 DateTime: date and time the image was taken, extracted from the file's 

metadata or file creation time. 
•	 DeleteFlag: allows the analyst to ‘flag’ particular images for later deletion.

Other data types are available. A later section will show you how to use 
these to create custom data fields specific to your project.  

Data field attributes 
Each data field has several attributes, presented as columns in the data table.

•	 Type is the type of interactive control used to represent the data field. 
The Type determines the look and feel of the control and constrains what 
data is entereded into it. For example, a Note type present a text field 
that can accept any textual data, an IntegerPositive presents a field with 
an increment/decrement control that can accept only positive integers, 
while a Flag type presents a clickable checkbox representing true or false.  
Types are described in greater detail in the Data types section. 

•	 Default Value is the initial value of that data when images are first loaded 
into Timelapse. The value can be empty. 

•	 Label is used to label the data field when it is displayed in the Timelapse 
user interface. Labels can comprise any text, and can be the same or 
different from the DataLabel attribute. 

•	 DataLabel names the database column that stores the data in the 
Timelapse database .ddb file.  The DataLabel also appears as the column 
name in the Timelapse Data Table tab, and the exported .CSV file. 
DataLabels must be unique, and its text can only comprise a mix of 
alphanumeric letters and ‘_’. 

•	 Tooltip defines the text displayed in the Timelapse interface when the 
analyst hovers their mouse over a data field. Its purpose is to serve as a 
brief help message explaining what that data field is for.
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•	 List applies only to Choice and MultiChoice items. A list defines a textual 
list, whose values are used to create a drop-down menu associated with 
each Choice or MultiChoice data field. This will be demonstrated shortly. 
Note. The DefaultValue of a Choice row must be either empty (if allowed 
as a List option), or must match an item in the Choice's List. Mismatches 
will result in a warning dialog.

•	 Width defines the width of the text box associated with data field. While 
the units are somewhat arcane, you can see the result of changing the 
width in the user interface preview area. Ideally, the width will be just 
wide enough to display expected values. 

•	 Copyable defines whether that field is affected by the Copy previous 
values button in the Timelapse interface. When the Copy previous values 
button is pressed, only those fields marked as copyable will have its data 
copied from the previous image to the current image.  

•	 Visible defines whether the field should be displayed in the Timelapse 
user interface. If marked as invisible, fields and their default values 
will still appear in the Timelapse data table and the exported .CSV file. 
Marking fields as invisible is useful for 
	» hiding fields that are optional,
	» hiding fields that are unneeded by the analyst for this image set,
	» reducing unnecessary clutter in the Timelapse data entry panel.

•	 Export defines whether a field and its values should be exported to a .CSV 
file. This is useful to exclude unneeded fields from the exported data, e.g., 
fields that help the image analysis process, but which will not be used 
later. For example: 
	» 	because the DeleteFlag is used internally to tag images that Timelapse 

should delete, its Export attribute is unchecked by default. This is why 
it is not included as a column in the spreadsheet preview area.

	» because File and RelativePath are required by a CSV row to identify 
the name and location of the image or video file, its Export attribute is 
checked by default and cannot be edited. 

You cannot delete mandatory data rows (i.e. those who are colored gray). 
However, you can edit some of their properties, as will be shown shortly. 

Data types
Aside from the mandatory data fields, you can create your own custom data 
fields specific to your project. The field can be one of following data types, 
each selectable from the Row addition / deletion controls panel.   
•	 Text... contains three types

	» Note is for entering short text. They can include any text values.
	» MultiLine is for longer text, entered in a drop-down box. They can 

include any values as well as line breaks.
	» Alphanumeric is similar to a note, except it only accepts letters (A-z), 

numbers (0-9) and dashes (-_). They are normally used for IDs. 

•	 Numbers... contains five types. All restrict text entry to numbers or 
blanks. All allow direct text editing, and all include up/down toggles to 
increment or decrement the current value. 
	» Integer is restricted to negative or positive integers. 
	» Integer Positive is for entering positive integers.
	» Decimal is for entering negative or positive decimal numbers. 
	» Decimal Positive is for entering positive decimal numbers. 
	» Count is a IntegerPositive specialized as a counter. The analyst can 

enter a count by selecting the Count control and clicking atop an 
entity in the image. This both increments the count and leaves a 
marker atop the image at that location. A Count is normally used for 
counting and keeping track what has been counted  in an image, e.g., 
number of deer.  

 



- 8 of 16 -Timelapse Template Guide Timelapse Manual Series: Part 3

•	 Choices... offer a fixed set of textual items (provided by the project 
manager in the Choice's List attribute) presented as a drop-down menu. 
Choice values are restricted to text matching those items
	» Fixed Choice  is for selecting one item from a menu. Depending on the 

setting in the Choice's List attribute, a FixedChoice may also include an 
empty item.   

	» MultiChoice  is for selecting multiple items from a menu, where 
selected items appear as alphabetically ordered comma separated 
values. 

•	 Dates/Times... are restricted to entering a data, a time, or both. They 
are in addition to the DateTime used by Timelapse to store the image's 
creation date and time.
	» DateTime_  is a date + time control that can be set by the user.   
	» Date_  is a date only control. Time is not included. 
	» Time_  is a time only. Date is not included. 

•	 Flags are for setting true / false values. The checkbox control that appears 
for flags stores data as  true when checked, or false when unchecked. 

Customizing the template: Image data fields
Perhaps one of the best things about Timelapse is that you can design and 
customize your data fields so they fit your project needs. 

We show how you can do this by example, where you will produce a 
template. This first part describes how you can create a template defining 
data fields for tagging your images (i.e., using the image data field tab). 

Let's assume you have thought deeply about the data fields you want. You 
decided your project should include the following five tags. 

Label Type Default value Purpose Choice items
Species FixedChoice Identifies wildlife Bear

Bobcat
Coyote, 
Wolf
Empty

Number Count 0 # wildlife present

Comment MultiLine Optional comment 
by the analyst

Problem MultiChoice Identifies one 
or more camera 
problems

Lens dirty
Lens wet or snowy
Camera misdirected
Vegetation obstruction

Publicity? Flag false A great photo

The label that appears in the user interface is the one identified above, 
but you also want the data base label (which will name the columns in the 
exported CSV file) to be in lower case and have an img_ prefix. 

1.	 Open the previously created template, and select the image data field tab
2.	 Create data fields based on the above by first selecting their Types.  

	» Choices |Choose one item from a list , 
	» Number | Count, 
	» Text | MultiLine, 
	» Choices |Choose one item from a list, 
	» Flag 
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3.	 The template will resemble the following. Each data field's specification is 
filled in with default values. A preview of how these fields will appear in 
the Timelapse interface is in the middle, while a preview of how they will 
appear as column headers in the .csv file is at the bottom. 

4.	 Edit each row to set each field's attributes. Change their Label and Data 
Label to meaningful ones, add informative tooltips, and alter the width of 
the data field if you wish. Turn of the Copyable attribute for Number and 
Comments, as these are likely image-specific. Turn off DateTime visibility 
as your analyst will not care about it. While it disappears from the 
Timelapse preview pane, it is still present in the .csv file headers preview 
which includes setting a more meaningful label to Number and Publicity.  

 

5.	 Add menu items to the Species Choice List. Click the Define List button, 
which raises a list editor. Type the species into the list, one per line. 
Because you also want the option to have this field set to empty, click 
the option Include and 'empty' item. This will add a blank entry to the 
drop-down menu when it appears in Timelapse. If you want to set a 
default values for your choice, it must match one of the items in the list. 

6.	 Similarly, add items to the Problem Choice List. It is similar to what is 
above, except that there is no option to include an empty item. (There is 
no need for it, as having all items deselected is an empty item).

7.	 Rearrange the controls in the user interface. Move the Delete? field to 
the end of the user interface by dragging the Delete? label in the user 
interface preview area, and dropping it atop the Publicity? label. 

8.	 Similarly, rearrange the order of columns as they would be written to a 
.csv file. In the .csv preview area, drag the img_comment field and drop it 
to just after the img_publicity field.
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9.	 Test the results in Timelapse. All the fields you created are no visible 
(except DateTime, as you had turned off its visibility). 

Customizing the template: Folder data fields
Timelape includes an entirely optional feature that allows you to create data 
fields for the folders / sub-folders in your image set, which the image set 
analyzer can fill in as they navigate through different image folders. Folder-
level data is also known as metadata (different from image metadata), as 
it often describes higher level aspects of your data sets rather than image 
details. See the Timelapse Metadata Guide for details.

Metadata can be extremely useful, although it does depend upon how you 
organize your image set folder structure. For example: 

•	 Metadata can describe organizational information about your image set, 
such as project descriptions, camera station specifics, deployment details, 
and pretty well anything else.

•	 It can implement a metadata standard shared within and/or between 
organizations and agencies. If you adhere to that standard, you will be 
able to share your data with others, and conversely understand the data 
they may want to share with you.

As with image data fields,  folder-level metadata is defined in the Timelapse 
template .tdb file, normally by a project manager. This is illustrated in the 
next section. 

Alternately, standardized templates may be provided by various agencies or 
government bodies for promoting cross-institutional sharing of ecological 
data between disparate agencies. These will normally include both folder 
and image-level data fields. 

Important note. The Timelapse Metadata Guide is required reading if you 
are thinking about using folder data fields. While it explains its benefits, it 
also describes why it is important to think deeply about the folder hierarchy 
you will be defining for your image set. Using folder data also adds several 
constraints:
- the image set's folder structure must match the folder-level organization  
  for this to work properly;
- future revisions to your folder organization can become difficult to do, 
- there are added nuances in dealing with advanced Timelapse aspects  
  such as creating and using master databases.  

https://timelapse.ucalgary.ca/Guides
https://timelapse.ucalgary.ca/Guides
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Defining your folder levels
Using folder levels assumes that analysts will structure their images into 
a particular hierarchical folder organization,  and that each folder level 
can be associated with meaningful data that would be unwieldy to do at a 
'per image' level i.e., metadata. For example (and this is just an example), 
consider the following folder organization and data fields associated with 
each folder level.

•	 Project folder (the root folder) contains all images for the current project. 
Data fields associated with the root folder are listed below. Because the 
contact person is the same across different project, their email can be 
supplied as a default.

Label Type Default value Purpose
Project name Note Names the project 

Purpose MultiLine What the project is for

Contact Note saul@ucalgary.ca Email of the person in charge

•	 Station folder are sub-folders within the root (Project) folder. Each folder 
is associated with a camera station placement. Data fields associated with 
each station folder are listed below. 

Label Type Default value Purpose
Latitude DecimalPositive 0 Camera location in decimal

Longitude DecimalPositive 0 Camera location in decimal

Description MultiLine Description of this location

•	 Deployment folder are sub-folders within each Station folder. Each folder 
is associated with an SD card retrieval. Images from that SD card are 
stored within this folder. Data fields associated with each deployment 
folder are listed below.

Label Type Default value Purpose
Retrieval date Date_ Date the SD card was retrieved

Camera ID Alphanumeric ID of the camera

Trigger mode FixedChoice Whether the camera is in timelapse 
or motion triggered mode.

Camera state Multiline The state of the camera, whether it 
was replaced, etc.

Consider the implications of the above structure on an image located in (for 
example) the folder <Root folder>/Station1/Deployment1a. 

•	 Because the image is in the Deployment1a folder (where its metadata 
was filled in), we know when it was retrieved, what camera was used and 
its trigger mode, and the state of the camera. 

•	 Because the Deployment1a  folder is in the Station1 folder, we also know 
the latitude and longitude that defines where that image was taken, as 
well as a description of that location.

•	 Because the Station1 folder is in the root (Project) folder, we know 
identify what project that image belongs to, the project's purpose, and 
who to contact. 

Now consider an image located in <Root folder>/Station1/Deployment1b. 
As its in a different deployment folder, the image would have different 
deployment metadata associated with it. However, as that deployment 
folder is under the same Station1 and root (Project) folder as the previous 
image, it would share the same Station1 and Project metadata.

Creating your folder levels
Let's create the above specification in the Template Editor.

1.	 Start the Timelapse Template Editor and open your previously created 
template file, where you have previously defined your image-level data 

2.	 Select the 'Folder data fields' tab. This tab is used to define folder-level 
data fields. You should see some brief instructions on creating folder-level 
data fields, as illustrated below.
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3.	 Select Folder levels | Add folder level from the menu bar. A new tab will 
appear within the Folder data fields tab, with a default title of Root-0. 
While similar to the editor seen in the image data field tab, it does have a 
few differences.  

4.	 Repeat the above, creating two more levels.  

 

5.	 Name each level: Project, Station, Deployment. Tab titles will update to 
its name. 

6.	 Add data fields to the Project level. This works in exactly the same way 
as adding image-level data fields. The only differences are that only your 
own custom fields are present, there are no Copyable attributes, and the 
Preview pane orders the controls vertically rather than horizontally. 

7.	 Create data fields for the Station and Deployment levels using the 
specifications described earlier (but feel free to add your own).

8.	 Using Timelapse, open this template on an image set. Either:
	» delete the previously created database (.ddb) file in your 

TemplatePractice folder and create a new one by opening Timelapse 
on your template, or

	» open Timelapse on your previously created database (.ddb) file in the 
TemplatePractice folder. You will see a warning that the template has 
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changed and an option to open it with the new template. Do so
9.	 Select the Folder data tab. You will see three folder tabs equivalent to 

what you just created. Select the Project tab, then Click to edit data for 
this folder. You will see the data fields you just created. Try the other tabs 
as well. 

Templates and existing metadata standards
Several standards exist that define expected image data fields, as well as an 
information hierarchy and associated data fields similar to  Timelapse's folder 
levels. Their purpose is to facilitate data-sharing between organizations. 
This, of course, suggests that the problem with standards is that there are so 
many to choose from!

The Timelapse Template Editor now includes a new menu item that will 
create a template based on an existing standard:
	 File|New template based on standard... 

Templates constructed from a standard can be edited if desired. For 
example, one can to hide unwanted fields, elaborate tooltips, and add extra 
fields particular to your project, etc. The caveat is that such changes may 
violate the standard, making it more difficult to share data with others.

Modifying templates after they are used
There may be times when you want to change a template after its been 
deployed and used to tag images in an image set. The revised template may 
have new, renamed and/or deleted data field, or some of their attributes 
may have changed. This may seem problematic, as the analyst has already 
entered data matching the old  template.
The good news is that Timelapse tries to accommodate changes to the 
template, where most modifications are easily managed, albeit with some 
caveats for changes in folder levels. 

Whenever you open an image set, Timelapse compares your template's data 
field specifications in the template .tdb file against the data specifications 
used in your data .ddb file. If it detects significant differences, it will notify 
you via a dialog box)of any implications your modifications may have on your 
stored data. It also offers choices to carry through or abort the operation.

Note: modifications involving changes to the DataLabel attribute require 
special care, as the DataLabel defines how data is stored and retrieved in 
the Timelapse database. 

Modifying a data field's appearance and order 
Most modifications to a data field's attributes only alters how that field 
appears or is ordered as a control in the Timelapse interface. These modifica-
tions do not affect how your existing and future data is stored and used. 
Consequently, changes will be applied automatically when you reload an 
image set with a template whose fields are modified as follows. No warnings 
will be issues, as they are not necessary.
•	 edit and alter the text in any field in a row EXCEPT Data Label; 
•	 change a field’s Copyable, Export, Visibility, Width ar Export attribute;
•	 change the position of data fields in the interface; 
•	 change the position of data fields in the .csv file;
•	 add items to the Choice menu. 
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Adding and deleting rows or renaming data labels
Adding data rows is safe, as existing data is unaffected. In contrast, deleting 
rows or renaming data labels have implications to the data already stored in 
a previously created image set, as described below.

Adding a new data field defines a new control that will appear in the 
Timelapse interface, and a new data column in the database and .CSV file. 
This is a safe operation, as it does not affect any existing data.

Deleting an existing data field indicates that you are no longer interested 
in that control or the data associated with it. The data field's control will no 
longer appear in the Timelapse interface and its data will be deleted. 

Important note about data field deletion. Lets repeat that to make sure 
you didn't miss it. When a data field is deleted, any previously entered data 
associated with that data field will be deleted from the Timelapse database, 
and consequently not exported to the .CSV file.  
 
If you want to keep the data, then just uncheck the control’s visibility field 
instead of deleting it.

Renaming a control by changing its data label leads to ambiguity when 
the template is opened in Timelapse. For example, let's say you changed the 
DataLabel of Publicity to GreatShot. This can be interpreted in one of two 
ways.

•	 Delete the Publicity data field, and then add a new (different) GreatShot 
data field. In this interpretation, Timelapse would delete the data 
associated with the original Publicity data label;

•	 Renaming Publicity to GreatShot. In this interpretation, Timelapse would 
simply rename the data column, keeping the data but storing it under the 
new GreatShot data label.  

Timelapse cannot tell which interpretation it should use. 

Consequently, Timelapse  will raise a dialog box asking you what it should do 
whenever ambiguities exists between deletions vs. renaming. 

Using the above example, the following dialog would appear.  If you wanted 
to keep the data previously associated with Publicity, you would click on 
Rename and select GreatShot from the drop-down menu. The  

Deleting and renaming items in a Choice list
A Choice data field's list is used to display a selectable menu of possible 
values for that field. Furthermore, Choice fields can only display text that 
match at least one of its menu items. Consequently, if you use the template 
to delete or change the name of an item in the Choice list, Timelapse will 
detect this and will warn you in a dialog. It will say that it cannot display 
previously entered data that matches the missing item(s). 

Even so, no data is deleted. While Timelapse cannot display that text in the 
data field if it differs, it still stores the original text in the data base.

Changing a data field's type
Each Type data field containes a drop-down menu that will allow you to 
change its type. Type changes demand some thought if the template was 
previously used to open an image set, where it would be used again to 
reopen that image set. The issue is that changing a data field's type to any 
other type can affect the previously entered data if not done carefully, as 
described below.    
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Consider type changes and their effects on previously entered data (as in the 
2nd point above).

•	 Equivalent types are those where you can convert back and forth 
between them with no effect on the data. For example, converting 
back and forth between an IntegerPositive and Counter is possible as 
those controls only store positive numbers as data. Similarly, converting 
between Note and MultiLine has no data effecdt as both controls contain 
arbitrary text. 

•	 Specialize type to a more general type should be considered a one-way 
type change. For example, converting a PositiveInteger to a DecimalAny 
works because previously entered data would only contain postive 
integers, which can also be expressed as a decimal number. The reverse, 
however, isn't true as it would be an unsafe type change, described next.  

•	 unsafe type changes are those where you try to convert from a general 
type to a more specialized type. For example, converting a DecimalAny 
to a PositiveInteger is unsafe, as there is no guarantee that previously 
entered decimal numbers are contrained to positive integers (e.g., 
-2.345). Similarly, trying to convert a text field such as MultiLine into 
(say) a DecimalAny can fail as previously entered text data may not be 
constrained to decimal numbers. 

To simplify things and lead to safe type conversions, Timelapse will normally 
display only a subset of type-safe changes in its dropdown menu, i.e., where 
changing from one type to another won't affect data in a previously opened 
image set. For example, consider the different dropdown menus shown by 
the MultLine type and the IntegerPositive type.  

      

The MultiLine control type can only be converted into another control type 
that can take arbitrary text, in this case a Note type.  The IntegerPositive 

control type can be converted to any of the other number controls (as 
they all accept positive integers) and to any of the other text controls (as a 
positive integer can be written as text, including alphanumeric text).

However, there are times when you may want to perform an unsafe type 
change. For example, 

•	 its a new template and  you changed your mind on the data type;
•	 the template has not been used to open an image set;
•	 there are no plans to apply this modified template to an image set 

previously opened with the original template;
•	 you just changed a data type from a specialized to a general type, but 

want to undo that change before opening any image set with it. 

In the above cases, changing a data field's type to any other type can be 
done safely as it will not be applied to any previously entered data. To permit 
this, press the Shift key while opening the dropdown menu. Timelapse 
will  list all data types and allow you to select one, even unsafe ones.  For 
example, here are the two previous controls when the Shift key is pressed. 
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Renaming and modifying folder levels
While Timelapse is fairly robust in terms of letting you modify your 
template's data fields, it is less tolerant to changes in your Folder levels. This 
is because it would be easy to generate an incompatible  mismatch between 
the folder levels defined in your template vs. the folder/subfolder structure 
you created as part of your image set. 

You can still modify the data fields within a folder level as described in the 
previous section. 

Timelapse will warn you when it detects folder level incompatibilities, where 
it will retain the old folder level structure rather than trying to use the one 
defined in the template. 

What is the problem with changing folder levels?
Image you have defined 3 folder levels: Project, Station, and Deployment. 
Your current folder levels are structured similarly, e.g., subfolders Station1, 
Station2... each with subfolders Deployment1, Deployment2, etc.

While your old stations had just a single camera at each location, you 
have begun using multiple cameras at some stations. Consequently, 
you modified the template to add a Camera level between Station and 
Deployment. 

The problem is that your existing subfolders (and the data associated with 
them) would have to be restructured to match the new folder levels. For 
the new folder levels to work, you would have to add (say) Camera1 and 
Camera2 subfolders under Station1, and move Station1's Deployment1 
folder to the correct Camera subfolder. Timelapse would have to know 
what was moved around, which is difficult. The result would be lost or 
misplaced data.

Future versions of Timelapse will attempt to mitigate this problem. 
For now, Timelapse will warn you when it detects folder level incompatibil-
ities, where it will retain the old folder level structure rather than trying to 
use the one defined in the template.
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